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1. CERTIFICATION 

PRODUCT: Smart Phone 

MODEL NO.:  PC36100 

BRAND:  HTC 

APPLICANT:  HTC Corporation 

TESTED:  Mar. 03 ~ Mar. 05, 2010 

TEST SAMPLE:  ENGINEERING SAMPLE 

STANDARDS:  FCC Part 2 (Section 2.1093) 

FCC OET Bulletin 65, Supplement C (01-01) 

RSS-102 

The above equipment (model: PC36100) has been tested by Bureau Veritas Consumer 

Products Services (H.K.) Ltd., Taoyuan Branch , and found compliance with the 

requirement of the above standards. The test record, data evaluation & Equipment Under 

Test (EUT) configurations represented herein are true and accurate accounts of the 

measurements of the sample’s EMC characteristics under the conditions specified in this 

report. 

PREPARED BY :  

 

,  DATE:  Mar. 18, 2010 

  Pettie Chen / Specialist   

TECHNICAL 
ACCEPTANCE 

 
: 

 

,  DATE:  Mar. 18, 2010 
Responsible for RF  Mason Chang / Engineer   

 
APPROVED BY  

 
: 

 
 

,  DATE:  Mar. 18, 2010 

  Gary Chang / Assistant Manager   
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2. GENERAL INFORMATION 

2.1 GENERAL DESCRIPTION OF EUT 

EUT Smart Phone 

MODEL NO. PC36100 

FCC ID NM8PC36100 

POWER SUPPLY 
3.7Vdc (Battery) 
5.0Vdc (Adapter) 
5.0Vdc (host equipment) 

MODULATION TYPE OQPSK, HPSK 

FREQUENCY RANGE 824MHz ~ 849MHz ; 1850MHz ~ 1910MHz 

CDMA850 BAND:  

SO55 RC3 23.96dBm / 836.5MHz for channel 384 

TDSO SO32 
RC3 23.94dBm / 836.5MHz for channel 384 

CDMA1900 BAND:  

SO55 RC3 
23.92dBm / 1851.25MHz for channel 25 
23.79dBm / 1880.00MHz for channel 600 
23.48dBm / 1908.75MHz for channel 1175 

CHANNEL FREQUENCIES 
UNDER TEST AND ITS 
CONDUCTED OUTPUT POWER 

TDSO SO32 
RC3 

23.88dBm / 1851.25MHz for channel 25 
23.74dBm / 1880.00MHz for channel 600 
23.42dBm / 1908.75MHz for channel 1175 

HEAD: 1.030W/kg  
MAX. AVERAGE SAR (1g) 

BODY: 0.961W/kg   

ANTENNA TYPE PIFA antenna 

ANTENNA GAIN  
CDMA850 BAND: -3.0dBi 
CDMA1900 BAND: 1.0dBi 

DATA CABLE Refer to NOTE 

I/O PORTS Refer to user’s manual 

ACCESSORY DEVICES Refer to NOTE 
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NOTE:  
1. The EUT is a Smart Phone. The functions of EUT listed as below: 

 REFERENCE REPORT 

WLAN 802.11b/g SA990210L08 

WIMAX SA990210L08-1 

BLUETOOTH SA990210L08-2 

CDMA 850 + CDMA 1900 SA990210L08-3 

HAC SA990210L08-4 

T-Coil SA990210L08-5 

2. The EUT has following accessories. 

NO. PRODUCT BRAND MANU- 
FACTURE 

MODEL DESCRIPTION 

1 Delta TC U250 

2 

Power 
Adapter hTC 

Emerson TC U250 

I/P: 100-240Vac, 50-60Hz, 200mA 
O/P: 5Vdc, 1A 

3 MEC - 

4 
USB cable 

Foxlink - 
DC M410 1.4m shielded cable without core 

(For data transmission & charging use) 

5 HT ENERGY - 

6 
Battery 

Formosa - 
RHOD160 Rating: 3.7Vdc, 1500mAh 

3. MEID code: A100000D98. 

4. The above EUT information was declared by manufacturer and for more detailed features description, 
please refer to the manufacturer's specifications or User's Manual. 

 

 

 
2.2 SAR MEASUREMENT CONDITIONS FOR CDMA 
 
The following procedures were followed according to FCC “SAR Measurement 
Procedures 3G Devices”, Oct. 2007. 
 
� Output Power Verification 

Maximum output power is verified on the High, Middle and Low channels according to 
procedures in section 4.4.5.2 of 3GPP2 C.S0011/TIA-98-E. Results for at least steps 3, 4 
and 10 of the power measurement procedures should be tabulated in the SAR report. 
Steps 3 and 4 should be measured using SO55 with power control bits in “All Up” condition. 
TDSO / SO32 may be used instead of SO55 for step 4. Step 10 should be measured using 
TDSO / SO32 with power control bits in the “Bits Hold” condition (i.e. alternative Up/Down 
Bits). All power measurements defined in C.S0011/TIA-98-E that are inapplicable to the 
DUT or cannot be measured due to technical or equipment limitations should be clearly 
identified in the test report.6 



 

Report No.: SA90210L08-3 6 Report Format Version 3.0.1 
 

 
  
� Head SAR Measurement  

SAR for head exposure configurations is measured in RC3 with the DUT configured to 
transmit at full rate using Loopback Service Option SO55.  SAR for RC1 is not required 
when the maximum average output of each channel is less than ¼ dB higher than that 
measured in RC3.  Otherwise, SAR is measured on the maximum output channel in RC1 
using the exposure configuration that results in the highest SAR for that channel in RC3. 
 
� Body SAR Measurements  

SAR for body exposure configurations is measured in RC3 with the DUT configured to 
transmit at full rate on FCH with all other code channels disabled using TDSO / SO32. SAR 
for multiple code channels (FCH + SCHn) is not required when the maximum average 
output of each RF channel is less than ¼ dB higher than that measured with FCH only. 
Otherwise, SAR is measured on the maximum output channel (FCH + SCHn) with FCH at 
full rate and SCH0 enabled at 9600 bps using the exposure configuration that results in the 
highest SAR for that channel with FCH only.  
When multiple code channels are enabled, the DUT output may shift by more than 0.5 dB 
and lead to higher SAR drifts and SCH dropouts. Body SAR in RC1 is not required when 
the maximum average output of each channel is less than ¼ dB higher than that measured 
in RC3. Otherwise, SAR is measured on the maximum 
output channel in RC1; with Loopback Service Option SO55, at full rate, using the body 
exposure configuration that results in the highest SAR for that channel in RC3. 
 
� Handsets with Ev-Do 
For handsets with Ev-Do capabilities, when the maximum average output of each channel 
in Rev. 0 is less than ¼ dB higher than that measured in RC3 (1x RTT), body SAR for 
Ev-Do is not required. Otherwise, SAR for Rev. 0 is measured on the maximum output 
channel at 153.6 kbps using the body exposure configuration that results in the highest 
SAR for that channel in RC3.  SAR for Rev. A is not required when the maximum average 
output of each channel is less than that measured in Rev. 0 or less than ¼ dB higher than 
that measured in RC3.  Otherwise, SAR is measured on the maximum output channel for 
Rev. A using a Reverse Data Channel payload size of 4096 bits and a Termination Target 
of 16 slots defined for Subtype 2 Physical Layer configurations.  A Forward Traffic Channel 
data rate corresponding to the 2-slot version of 307.2 kbps with the ACK Channel 
transmitting in all slots should be configured in the downlink for both Rev. 0 and Rev. A.  
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2.3 SETTING OF CMU 200 
For 1xRTT (CDMA2000) 
Application                              Rev. License 

CDMA200 Cellular or CDMA200 PCS     V5.01 

Network>System Parameters>System ID Number(MID)>13505 

Network>Network Identity> Network ID Number (NID)>1 

Radio Config (RC)> Please see Following table or details 

FCH Service Option(SO) Setup > Please see Following table or details 

Traffic Data Rate >Full 

TDSO SCH Info >F-SCH Parameters> F-SCH Date Rate > 153.6kbps 

   >R-SCH Parameters> R-SCH Date Rate > 153.6kbps 

BS Signal>Power Control>Power Ctrl. Bits>>Auto 

BS Signal>Power Control>Power Ctrl. Bits>All Up (Maximum TxPout) 
 

CONDUCTED POWER OF 1x RTT at 850 BAND:  

CDMA  RAW VALUE (dBm) OUTPUT POWER (dBm) 

CHAN. 
FREQ. 

(MHz) RC SO2 SO55 

TDSO 

SO32 

(FCH) 

TDSO 

SO32 

(FCH+

SCH) 

CORR. 

FACTOR 

(dB) SO2 SO55 

TDSO 

SO32 

(FCH) 

TDSO 

SO32 

(FCH+ 

SCH) 

RC1 19.47  19.54  - - 4.2 23.67  23.74  - - 
1013 824.7 

RC3 19.51  19.58  19.53  19.49  4.2 23.71  23.78  23.73  23.69  

RC1 19.65  19.68  - - 4.2 23.85  23.88  - - 
384 836.5 

RC3 19.69  19.76  19.74  19.67  4.2 23.89  23.96  23.94  23.87  

RC1 18.80  18.87  - - 4.2 23.00  23.07  - - 
777 848.3 

RC3 18.81  18.91  18.82  18.84  4.2 23.01  23.11  23.02  23.04  

 

CONDUCTED POWER OF 1xRTT at 1900 BAND:  

CDMA 2000 CONDUCTED POWER 

CDMA 

2000 
RAW VALUE (dBm) OUTPUT POWER (dBm) 

CHAN. 
FREQ. 

(MHz) 
RC SO2 SO55 

TDSO 

SO32 

(FCH) 

TDSO 

SO32 

(FCH+S

CH) 

CORR. 

FACTOR 

(dB) SO2 SO55 

TDSO 

SO32 

(FCH) 

TDSO 

SO32 

(FCH+S

CH) 

RC1 19.18  19.31  - - 4.5 23.68  23.81  - - 
25 1851.25 

RC3 19.29  19.42  19.38  19.35  4.5 23.79  23.92  23.88  23.85  

RC1 19.14  19.18  - - 4.5 23.64  23.68  - - 
600 1880.00 

RC3 19.26  19.29  19.24  19.22  4.5 23.76  23.79  23.74  23.72  

RC1 18.81  18.85  - - 4.5 23.31  23.35  - - 
1175 1908.75 

RC3 18.96  18.98  18.92  18.78  4.5 23.46  23.48  23.42  23.28  
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For 1xEV-DO (Release 0) 
Application                           Rev. License 

1xEV-DO                              V5.01 

EVDO Release 0 – RTAP 

AN Signal>ANSN-41>Sector>ANSI-41 

Cell Power>-105.5dBm 

Cell Band>(Select US Cellular or N. American PCS) 

Channel>(Enter channel number) 

Network> Network Release > Release 0 

Application Selection>Test Application Select>Fwrd&Rvrse >Apply 

Layer>Test Applications >RTAP Cfg.>Data>153.6 kbps 

BS Signal>Power Control>Power Ctrl. Bits>>Auto 

Press “ Connect AT ” when “RL: Session Open” 

BS Signal>Power Control>Power Ctrl. Bits>All Up(Maximum TxPout) 

 

EVDO Release 0 – FTAP 

AN Signal>ANSN-41>Sector>ANSI-41 

Cell Power>-105.5dBm 

Cell Band>(Select US Cellular or N. American PCS) 

Channel>(Enter channel number) 

Network> Network Release > Release 0 

Application Selection>Test Application Select>Fwrd&Rvrse >Apply 

Layer>Test Applications>FTAP Cfg.>DRC.>307.2 kbps(2 Slot) 

BS Signal>Power Control>Power Ctrl. Bits>>Auto 

Press “ Connect AT ” when “RL: Session Open” 

BS Signal>Power Control>Power Ctrl. Bits>All Up(Maximum TxPout) 
CONDUCTED POWER OF EVDO-RELEASE 0 AT 850 BAND 

FTAP rate RTAP Rate Channel  f(MHz) 
Conducted power 

(dBm) 

1013 824.7 23.42 

384 836.52 23.63 307.2k 153.6 kbps 

7 848.31 22.94 

CONDUCTED POWER OF EVDO-RELEASE 0 AT 1900 Band  

FTAP rate RTAP Rate Channel  f(MHz) 
Conducted power 

(dBm) 

25 1851.25 23.56 

600 1880.00 23.33 307.2k 153.6 kbps 

1175 1908.75 23.07 

 
NOTE: Conducted power of EV-DO release 0 mode is less than 1/4 dB higher than 1xRTT MODE, body SAR 

of EV-DO release 0 mode will be reduced. 
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For 1xEV-DO (Release A) 
Application                           Rev. License 

1xEV-DO          t                  V5.01 

EVDO Release A - RTAP 

Cell Power>-60 dBm 

Network> Network Release > Release A 

Application Selection>Test Application Select>Fwrd&Rvrse >Apply 

Layer>Test Applications >RTAP Cfg.>Data>4096 kbps 

Subtype>2 (Default) 

AN Signal>ANSN-41>Sector>ANSI-41 

Network>Access Probes>16 Slots 

BS Signal>Power Control>Power Ctrl. Bits>All Up(Maximum TxPout) 

 

EVDO Release A - FTAP 

Cell Power>-60 dBm 

Network> Network Release > Release A 

Application Selection>Test Application Select>Fwrd&Rvrse >Apply 

Layer>Test Applications >FTAP Cfg.>DRC>Rate>307.2 kbps 2-slot 

Layer>Test Applications >FTAP Cfg.>ACK Ch. Fixed Mode>NACK Always 

Subtype>2 (Default) 

AN Signal>ANSN-41>Sector>ANSI-41 

Network>Access Probes>16 Slots 

BS Signal>Power Control>Power Ctrl. Bits>All Up(Maximum TxPout) 

 
CONDUCTED POWER OF EVDO-RELEASE AAT 850 BAND 

FETAP-Traffic Format  
RETAP-Data Payload 

Size 
Channel  f(MHz) 

Conducted power 
(dBm) 

1013 824.7 23.40 

384 836.52 23.52 
307.2k, QPSK/ACK 

channel is transmitted 
at all the slots 

4096 

7 848.31 22.78 

CONDUCTED POWER OF EVDO-RELEASE A AT 1900 BAND 

FETAP-Traffic Format  
RETAP-Data Payload 

Size 
Channel  f(MHz) 

Conducted power 
(dBm) 

25 1851.25 23.39 

600 1880.00 23.34 
307.2k, QPSK/ACK 

channel is transmitted  
at all the slots 

4096 

1175 1908.75 23.06 

 
NOTE: Conducted power of EV-DO release A mode is less than 1/4 dB higher than 1xRTT MODE, body 

SAR of EV-DO mode release A mode will be reduced. 
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2.4 GENERAL DESCRIPTION OF APPLIED STANDARDS 

According to the specifications of the manufacturer, this product must comply with the 
requirements of the following standards: 

FCC Part 2 (2.1093) 

FCC OET Bulletin 65, Supplement C (01- 01) 

RSS-102 

IEEE 1528-2003 

All test items have been performed and recorded as per the above standards. 
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2.5 GENERAL INOFRMATION OF THE SAR SYSTEM  

DASY5 (Software 5.2 Build 157)  consists of high precision robot, probe alignment sensor, 
phantom, robot controller, controlled measurement server and near-field probe. The robot 
includes six axes that can move to the precision position of the DASY5 software defined. 
The DASY5 software can define the area that is detected by the probe. The robot is 
connected to controlled box. Controlled measurement server is connected to the 
controlled robot box. The DAE includes amplifier, signal multiplexing, AD converter, offset 
measurement and surface detection. It is connected to the Electro-optical coupler (ECO). 
The ECO performs the conversion form the optical into digital electric signal of the DAE 
and transfers data to the PC. 

 

EX3DV3 ISOTROPIC E-FIELD PROBE  

CONSTRUCTION Symmetrical design with triangular core 
Built-in shielding against static charges 
PEEK enclosure material (resistant to organic solvents, e.g., DGBE) 

FREQUENCY 10 MHz > 6 GHz 
Linearity: ± 0.2 dB (30 MHz to 6 GHz) 

DIRECTIVITY ± 0.3 dB in HSL (rotation around probe axis) 
± 0.5 dB in tissue material (rotation normal to probe axis) 

DYNAMIC RANGE  10 μW/g to > 100 mW/g 
Linearity: ± 0.2 dB (noise: typically < 1 μW/g) 

DIMENSIONS Overall length: 330 mm (Tip: 20 mm) 
Tip diameter: 2.5 mm (Body: 12 mm) 
Typical distance from probe tip to dipole centers: 1 mm 

APPLICATION  High precision dosimetric measurements in any exposure scenario 
(e.g., very strong gradient fields). Only probe which enables 
compliance testing for frequencies up to 6 GHz with precision of better 
30%. 

NOTE 
1. The Probe parameters have been calibrated by the SPEAG. Please reference “APPENDIX D” for the 

Calibration Certification Report. 
2. For frequencies above 800MHz, calibration in a rectangular wave-guide is used, because wave-guide 

size is manageable. 
3. For frequencies below 800MHz, temperature transfer calibration is used because the wave-guide size 

becomes relatively large. 
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TWIN SAM V4.0 

CONSTRUCTION The shell corresponds to the specifications of the Specific 
Anthropomorphic Mannequin (SAM) phantom defined in IEEE 
1528-2003, EN 62209-1 and IEC 62209. It enables the 
dosimetric evaluation of left and right hand phone usage as 
well as body mounted usage at the flat phantom region. A 
cover prevents evaporation of the liquid. Reference markings 
on the phantom allow the complete setup of all predefined 
phantom positions and measurement grids by manually 
teaching three points with the robot. 

SHELL THICKNESS  2 ± 0.2mm 

FILLING VOLUME  Approx. 25liters 

DIMENSIONS Height: 810mm; Length: 1000mm; Width: 500mm 

SYSTEM VALIDATION KITS:  

CONSTRUCTION Symmetrical dipole with l/4 balun enables measurement of 
feedpoint impedance with NWA matched for use near flat 
phantoms filled with brain simulating solutions. 
Includes distance holder and tripod adaptor 

CALIBRATION  Calibrated SAR value for specified position and input power at 
the flat phantom in brain simulating solutions 

FREQUENCY 835, 1900MHz 

RETURN LOSS > 20dB at specified validation position 

POWER CAPABILITY  > 100W (f < 1GHz); > 40W (f > 1GHz) 

OPTIONS Dipoles for other frequencies or solutions and other calibration 
conditions upon request 
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DEVICE HOLDER FOR SAM TWIN PHANTOM  

CONSTRUCTION The device holder for the mobile phone device is designed to 
cope with different positions given in the standard. It has two 
scales for the device rotation (with respect to the body axis) 
and the device inclination (with respect to the line between the 
ear reference points). The rotation centers for both scales is the 
ear reference point (ERP). Thus the device needs no 
repositioning when changing the angles. The holder has been 
made out of low-loss POM material having the following 
dielectric parameters: relative permittivityε=3 and loss tangent
δ=0.02. The amount of dielectric material has been reduced in 
the closest vicinity of the device, since measurements have 
suggested that the influence of the clamp on the test results 
could thus be lowered. The device holder for the portable 
device makes up of the polyethylene foam. The dielectric 
parameters of material close to the dielectric parameters of the 
air. 

DATA ACQUISITION ELECTRONICS  

CONSTRUCTION The data acquisition electronics (DAE3) consists of a highly 
sensitive electrometer grade preamplifier with auto-zeroing, a 
channel and gain-switching multiplex, a fast 16 bit AD 
converter and a command decoder and control logic unit. 
Transmission to the measurement server is accomplished 
through an optical downlink for data and status information as 
well as an optical uplink for commands and the clock. The 
mechanical probe is mounting device includes two different 
sensor systems for frontal and sideways probe contacts. They 
are used for mechanical surface detection and probe collision 
detection. The input impedance of the DAE3 box is 200MOhm; 
the inputs are symmetrical and floating. Common mode 
rejection is above 80 dB. 
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2.6 TEST EQUIPMENT 
 
FOR SAR MEASURENENT  

ITEM NAME BRAND TYPE SERIES NO. 
DATE OF 

CALIBRATION  
DUE DATE OF 
CALIBRATION  

1 SAM Phantom S & P QD000 P40 CA TP-1150 NA NA 

2 
Signal 

Generator 
Anritsu 68247B 984703 May 21, 2009 May 20, 2010 

3 E-Field Probe S & P EX3DV3 3504 Jan. 26, 2010 Jan. 25, 2011 

4 DAE S & P DAE 510 Dec. 16, 2009 Dec. 15, 2010 

5 
Robot 

Positioner 
Staubli 

Unimation 
NA NA NA NA 

6 
Validation 

Dipole 
S & P D835V2 4d021 May 25, 2009 May 24, 2010 

7 
Validation 

Dipole 
S & P D1900V2 5d022 Mar. 17, 2009 Mar. 16, 2010 

NOTE: Before starting, all test equipment shall be warmed up for 30min. 

 
FOR TISSUE PROPERTY 

ITEM NAME BRAND TYPE SERIES NO. 
DATE OF 

CALIBRATION  
DUE DATE OF 
CALIBRATION  

1 
Network 
Analyzer 

Agilent E5071C MY46104190 Apr. 10, 2009 Apr. 09, 2010 

2 Dielectric Probe Agilent 85070D US01440176 NA NA 

NOTE: 

1. Before starting, all test equipment shall be warmed up for 30min. 
2. The tolerance (k=1) specified by Agilent for general dielectric measurements, deriving from inaccuracies in 

the calibration data, analyzer drift, and random errors, are usually ±2.5% and ±5% for measured 
permittivity and conductivity, respectively. However, the tolerances for the conductivity is smaller for 
material with large loss tangents, i.e., less than ±2.5% (k=1). It can be substantially smaller if more 
accurate methods are applied
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2.7 GENERAL DESCRIPTION OF THE SPATIAL PEAK SAR EVA LUATION 

The DASY5 post-processing software (SEMCAD) automatically executes the following 
procedures to calculate the field units from the micro-volt readings at the probe connector. 
The parameters used in the evaluation are stored in the configuration modules of the 
software: 

Probe parameters: - Sensitivity Normi, ai0, ai1, ai2 

 - Conversion factor ConvFi 

 - Diode compression point dcpi 

Device parameters: - Frequency F 

 - Crest factor Cf 

Media parameters: - Conductivity σ 

 - Density ρ 

The first step of the evaluation is a linearization of the filtered input signal to account for the 
compression characteristics of the detector diode. The compensation depends on the 
input signal, the diode type and the DC-transmission factor from the diode to the evaluation 
electronics. If the exciting field is pulsed, the crest factor of the signal must be known to 
correctly compensate for peak power. The formula for each channel can be given as: 

i
iii dcp

cf
UUV •+= 2

 

Vi =compensated signal of channel i (i = x, y, z) 

Ui =input signal of channel I (i = x, y, z) 

Cf =crest factor of exciting field (DASY parameter) 

dcpi =diode compression point (DASY parameter) 
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From the compensated input signals the primary field data for each channel can be 
evaluated: 

 

E-fieldprobes: 
ConvFNorm

V
E

i
i ⋅

= 1  

 

H-fieldprobes: 
f

fafaa
VH iii

ii

2
210 ++⋅=  

 
Vi =compensated signal of channel I (i = x, y, z) 

Normi =sensor sensitivity of channel i µV/(V/m)2 for 
E-field Probes 

(i = x, y, z) 

ConvF = sensitivity enhancement in solution  

aij = sensor sensitivity factors for H-field probes  

F = carrier frequency [GHz]  

Ei = electric field strength of channel i in V/m  

Hi = magnetic field strength of channel i in A/m  

The RSS value of the field components gives the total field strength (Hermitian 
magnitude): 

222
zyxtot EEEE ++=  

The primary field data are used to calculate the derived field units. 

000'1
2

⋅
⋅=

ρ
σ

totESAR  

 

SAR = local specific absorption rate in mW/g 

Etot = total field strength in V/m 

σ = conductivity in [mho/m] or [Siemens/m] 

ρ = equivalent tissue density in g/cm3 
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Note that the density is set to 1, to account for actual head tissue density rather than the 
density of the tissue simulating liquid. The entire evaluation of the spatial peak values is 
performed within the Post-processing engine (SEMCAD). The system always gives the 
maximum values for the 1g and 10g cubes. The algorithm to find the cube with highest 
averaged SAR is divided into the following stages: 

1. The extraction of the measured data (grid and values) from the Zoom Scan 

2. The calculation of the SAR value at every measurement point based on all stored data 
(A/D values and measurement parameters) 

3. The generation of a high-resolution mesh within the measured volume 

4. The interpolation of all measured values from the measurement grid to the 
high-resolution grid 

5. The extrapolation of the entire 3-D field distribution to the phantom surface over the 
distance from sensor to surface 

6. The calculation of the averaged SAR within masses of 1g and 10g. 

The probe is calibrated at the center of the dipole sensors that is located 1 to 2.7mm away 
from the probe tip. During measurements, the probe stops shortly above the phantom 
surface, depending on the probe and the surface detecting system. Both distances are 
included as parameters in the probe configuration file. The software always knows exactly 
how far away the measured point is from the surface. As the probe cannot directly 
measure at the surface, the values between the deepest measured point and the surface 
must be extrapolated. The angle between the probe axis and the surface normal line is 
less than 30 degree. 
 
The maximum search is automatically performed after each area scan measurement. It is 
based on splines in two or three dimensions. The procedure can find the maximum for 
most SAR distributions even with relatively large grid spacing. After the area scanning 
measurement, the probe is automatically moved to a position at the interpolated maximum. 
The following scan can directly use this position for reference, e.g., for a finer resolution 
grid or the cube evaluations. The 1g and 10g peak evaluations are only available for the 
predefined cube 7 x 7 x 7 scans. The routines are verified and optimized for the grid 
dimensions used in these cube measurements. The measured volume of 30 x 30 x 30mm 
contains about 30g of tissue. The first procedure is an extrapolation (incl. boundary 
correction) to get the points between the lowest measured plane and the surface. The next 
step uses 3D interpolation to get all points within the measured volume in a 1mm grid 
(42875 points). In the last step, a 1g cube is placed numerically into the volume and its 
averaged SAR is calculated. This cube is the moved around until the highest averaged 
SAR is found. If the highest SAR is found at the edge of the measured volume, the system 
will issue a warning: higher SAR values might be found outside of the measured volume. In 
that case the cube measurement can be repeated, using the new interpolated maximum 
as the center. 
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3. DESCRIPTION OF SUPPORT UNITS 
 

NO. PRODUCT BRAND MODEL NO. SERIAL NO. 

1 
Universal Radio 

Communication Tester 
R&S CMU200 104484 

 

NO. SIGNAL CABLE DESCRIPTION OF THE ABOVE SUPPORT UNITS  

1 NA 

NOTE: All power cords of the above support units are non shielded (1.8m). 
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4. DESCRIPTION OF TEST MODES AND CONFIGURATIONS 

4.1. DESCRIPTION OF TEST POSITION 

 

 

FIGURE 3.1 

 
FIGURE 3.1a                                                                FIGURE 3.1b 
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4.1.1 TOUCH/CHEEK TEST POSITION 

The head position in Figure 3.1, the ear reference points ERP are 15mm above entrance to 
ear canal along the B-M line. The line N-F (Neck-Front) is perpendicular to the B-M (Back 
Mouth) line. The handset device in Figure 3.1a and 3.1b,The vertical centerline pass through 
two points on the front side of handset: the midpoint of the width wt of the handset at the level 
of the acoustic output (point A) and the midpoint of the width Wb of the bottom of the handset 
(point B). The vertical centerline is perpendicular to the horizontal line and pass through the 
center of the acoustic output. The point A touches the ERP and the vertical centerline of the 
handset is parallel to the B-M line. While maintaining the point A contact with the ear(ERP), 
rotate the handset about the line NF until any point on handset is in contact with the cheek of 
the phantom  

 

TOUCH/CHEEK POSITION FIGURE 
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4.1.2 TILT TEST POSITION 

Adjust the device in the cheek position. While maintaining a point of the handset contact in 
the ear, move the bottom of the handset away from the mouth by an angle of 15 degrees. 

 
TILT POSITION FIGURE 

4.1.3 BODY-WORN CONFIGURATION 

The handset device attached the belt clip or the holster. The keypad face of the handset is 
against with the bottom of the flat phantom face and the bottom of the keypad face contact 
to the bottom of the flat phantom. 

When multiple accessories that do not contain metallic components are supplied with the 
device, the device may be tested with only the accessory that dictates the closest spacing 
to the body.  When multiple accessories that contain metallic components are supplied with 
the device, the device must be tested with each accessory that contains a unique metallic 
component. If multiple accessories share an identical metallic component (e.g., the same 
metallic belt-clip used with different holsters with no other metallic components), only 
accessory that dictates the closest spacing to the body must be tested.  
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4.2.  DESCRIPTION OF TEST CONDITION 

TEMPERATURE (°C) 
TEST DATE TISSUE TYPE / 

FREQ. TEST MODE 
AIMBENT LIQUID 

HUMIDITY 
(%RH) TESTED BY 

Mar. 05, 2010 HSL835 1-4, 9 22.8 21.5 60 Sam Onn 

Mar. 05, 2010 MSL835 5-8 23.0 22.1 58 Sam Onn 

Mar. 03, 2010 HSL1900 10-13, 18 22.6 21.3 58 Sam Onn 

Mar. 03, 2010 MSL1900 14-17 22.4 21.2 61 Sam Onn 

 

4.3. DESCRIPTION OF TEST MODE 

ASSESSMENT 
POSTITION 

BATTERY 
TEST 
MODE 

COMMUNICATION 
MODE 

MODULATION 
TYPE 

TESTED 
CHANNEL 

Right Head / Cheek HT ENERGY Battery 1 CDMA 850 SO55 OQPSK 384 

Right Head / Tilt HT ENERGY Battery 2 CDMA 850 SO55 OQPSK 384 

Left Head / Cheek HT ENERGY Battery 3 CDMA 850 SO55 OQPSK 384 

Left Head / Tilt HT ENERGY Battery 4 CDMA 850 SO55 OQPSK 384 

Body / Back 
15mm-separation HT ENERGY Battery 5 CDMA 850 SO32 OQPSK 384 

Body / Front 
15mm-separation HT ENERGY Battery 6 CDMA 850 SO32 OQPSK 384 

Body / Back 
15mm-separation Formosa Battery 7 CDMA 850 SO32 OQPSK 384 

Right Head / Cheek HT ENERGY Battery 8 CDMA 1900 SO55 OQPSK 600 

Right Head / Tilt HT ENERGY Battery 9 CDMA 1900 SO55 OQPSK 25, 600, 1175 

Left Head / Cheek HT ENERGY Battery 10 CDMA 1900 SO55 OQPSK 25, 600, 1175 

Left Head / Tilt HT ENERGY Battery 11 CDMA 1900 SO55 OQPSK 25, 600, 1175 

Body / Back 
15mm-separation 

HT ENERGY Battery 12 CDMA 1900 SO32 OQPSK 25, 600, 1175 

Body / Front 
15mm-separation HT ENERGY Battery 13 CDMA 1900 SO32 OQPSK 600 

Left Head / Tilt Formosa Battery 14 CDMA 1900 SO55 OQPSK 25 
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5. TEST RESULTS 

5.1 TEST PROCEDURES 

The EUT makes a phone call to the communication simulator station. Establish the 
simulation communication configuration rather the actual communication. Then the EUT 
could continuous the transmission mode. Adjust the PCL of the base station could 
controlled the EUT to transmitted the maximum output power. The base station also could 
control the transmission channel. The SAR value was calculated via the 3D spline 
interpolation algorithm that has been implemented in the software of DASY5 SAR 
measurement system manufactured and calibrated by SPEAG. According to the IEEE 
1528 / EN 62209-1, the recommended procedure for assessing the peak spatial-average 
SAR value consists of the following steps: 

• Power reference measurement 

• Verification of the power reference measurement 

• Area scan 

• Zoom scan 

• Power reference measurement 

The area scan was performed for the highest spatial SAR location. The zoom scan with 
30mm x 30mm x 30mm volume was performed for SAR value averaged over 1g and 10g 
spatial volumes.  

In the zoom scan, the distance between the measurement point at the probe sensor 
location (geometric center behind the probe tip) and the phantom surface is 3mm and 
maintained at a constant distance of ±0.5mm during a zoom scan to determine peak SAR 

locations. The distance is 3mm between the first measurement point and the bottom 
surface of the phantom. The secondary measurement point to the bottom surface of the 
phantom is with 8mm separation distance. The cube size is 7 x 7 x 7 points consists of 343 
points and the grid space is 5mm. 
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The measurement time is 0.5s at each point of the zoom scan. The probe boundary effect 
compensation shall be applied during the SAR test. Because of the tip of the probe to the 
Phantom surface separated distances are longer than half a tip probe diameter. 

In the area scan, the separation distance is 3mm between the each measurement point 
and the phantom surface. The scan size shall be included the transmission portion of the 
EUT. The measurement time is the same as the zoom scan. At last the reference power 
drift shall be less than ±5%. 

 

5.2 SAR LIMITS 

SAR (W/kg) 

HUMAN EXPOSURE (GENERAL POPULATION / 
UNCONTROLLED 

EXPOSURE ENVIRONMENT) 

(OCCUPATIONAL / 
CONTROLLED EXPOSURE 

ENVIRONMENT) 

Spatial Peak  
(averaged over 1 g) 1.6 8.0 

NOTE: 

1. This limits accord to 47 CFR 2.1093 – Safety Limit. 

2. The EUT property been complied with the partial body exposure limit under the general population 
environment. 
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5.3 MEASURED SAR RESULTS 
 
Battery: HT Energy 

LEFT RIGHT 
CHEEK TILT CHEEK TILT Channel 

Measured  
Compen-  

sated 
Measured  

Compen-  
sated 

Measured  
Compen-  

sated 
Measured  

Compen-  
sated 

CDMA 850 Band 
384 0.455 0.443 0.284 0.276 0.351 0.341 0.202 0.196 

CDMA 1900 Band  
25 0.966 0.938 1.030 0.999   0.998 0.968 
600 0.828 0.781 0.927 0.875 0.705 0.664 0.867 0.816 
1175 0.939 0.858 1.000 0.913   0.977 0.891 

 
Battery: HT Energy 

FRONT 15mm-separation BACK 15mm-separation 
Channel  

Measured Compensated Measured Compensated 
CDMA 850 Band 

384 0.297 0.285 0.636 0.610 
CDMA 1900 Band  

25   0.953 0.917 
600 0.224 0.211 0.812 0.765 
1175   0.961 0.880 

 
Battery: Formosa 

LEFT 
TILT Channel 

Measured Compensated 

CDMA 1900 Band  
25 0.998 0.971 

 
Battery: Formosa 

BACK 15mm-separation 
Channel  

Measured Compensated 
CDMA 850 Band 

384 0.611 0.587 
 

NOTE:  

1. In this testing, the limit for General Population Spatial Peak averaged over 1g, 1.6 W/kg , is applied 

2. Please see the Appendix A for the data. 

3. The variation of the EUT conducted power measured before and after SAR testing should not over 5%. 

4. The calibrated frequency is beyond 50 MHz of measurement frequency.  Per KDB 450824 D01 requirements, the measured 1-g 

SAR is compensated with respect to +5% tolerances in ε r and -5% tolerances in σ. 
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5.4 RECIPES FOR TISSUE SIMULATING LIQUIDS 

For the measurement of the field distribution inside the SAM phantom, the phantom must 
be filled with 25 litters of tissue simulation liquid. 
 
The following are some common ingredients： 

• WATER- Deionized water (pure H20), resistivity _16 M - as basis for the liquid 

• SUGAR- Refined sugar in crystals, as available in food shops - to reduce relative 

permittivity 

• SALT- Pure NaCl - to increase conductivity 

• CELLULOSE- Hydroxyethyl-cellulose, medium viscosity (75-125mPa.s, 2% in water, 

20_C), 

CAS # 54290 - to increase viscosity and to keep sugar in solution 

• PRESERVATIVE- Preventol D-7 Bayer AG, D-51368 Leverkusen, CAS # 55965-84-9 - to 

prevent the spread of bacteria and molds 

• DGMBE- Diethylenglycol-monobuthyl ether (DGMBE), Fluka Chemie GmbH, 

CAS # 112-34-5 - to reduce relative permittivity 
 

THE RECIPES FOR 835MHz SIMULATING LIQUID TABLE 

INGREDIENT HEAD SIMULATING LIQUID 
835MHz (HSL-835) 

MUSCLE SIMULATING 
LIQUID 835MHz (MSL-835) 

Water 40.28% 50.07% 

Cellulose 02.41% NA 

Salt 01.38% 0.94% 

Preventtol D-7 00.18% 0.09% 

Sugar 57.97% 48.2% 

Dielectric Parameters 
at 22℃ 

f = 835MHz 

ε= 41.5 ± 5% 

σ= 0.97 ± 5% S/m  

f= 835MHz 

ε= 55.0 ± 5% 

σ= 1.05 ± 5% S/m  
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THE RECIPES FOR 1900MHz SIMULATING LIQUID TABLE  

INGREDIENT HEAD SIMULATING LIQUID 
1900MHz (HSL-1900) 

MUSCLE SIMULATING 
LIQUID 1900MHz 

(MSL-1900) 

Water 55.24% 70.16% 

DGMBE 44.45% 29.44% 

Salt 0.306% 00.39% 

Dielectric Parameters 
at 22℃ 

f= 1900MHz 
ε= 40.0 ± 5% 

σ= 1.40 ± 5% S/m  

f= 1900MHz 
ε= 53.3 ± 5% 

σ= 1.52 ± 5% S/m  
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Testing the liquids using the Agilent Network Analyzer E8358A and Agilent Dielectric Probe 
Kit 85070D.The testing procedure is following as 

1. Turn Network Analyzer on and allow at least 30min. warm up. 

2. Mount dielectric probe kit so that interconnecting cable to Network Analyzer will not be 
moved during measurements or calibration. 

3. Pour de-ionized water and measure water temperature (±1°). 

4. Set water temperature in Agilent-Software (Calibration Setup). 

5. Perform calibration. 

6. Validate calibration with dielectric material of known properties (e.g. polished ceramic 
slab with >8mm thickness ε'=10.0, ε''=0.0). If measured parameters do not fit within 
tolerance, repeat calibration (±0.2 for ε': ±0.1 for ε''). 

7. Conductivity can be calculated from ε'' by σ = ω ε0 ε'' =ε'' f [GHz] / 18. 

8. Measure liquid shortly after calibration. Repeat calibration every hour. 

9. Stir the liquid to be measured. Take a sample (~ 50ml) with a syringe from the center of 
the liquid container. 

10. Pour the liquid into a small glass flask. Hold the syringe at the bottom of the flask to 
avoid air bubbles. 

11. Put the dielectric probe in the glass flask. Check that there are no air bubbles in front of 
the opening in the dielectric probe kit. 

12. Perform measurements. 

13. Adjust medium parameters in DASY5 for the frequencies necessary for the 
measurements (‘Setup Config’, select medium (e.g. Brain 900MHz) and press 
‘Option’-button. 

14. Select the current medium for the frequency of the validation (e.g. Setup Medium Brain 
900MHz). 
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FOR CDMA850 BAND SIMULATING LIQUID 

LIQUID TYPE HSL-835 

SIMULATING LIQUID TEMP.  21.5 

TEST DATE Mar. 05, 2010 

TESTED BY Sam Onn 

FREQ. 
(MHz) 

LIQUID 
PARAMETER 

STANDARD 
VALUE 

MEASUREMENT 
VALUE 

ERROR 
PERCENTAGE 

(%%%%) 
LIMIT( % ) 

835.00 41.50  42.00  1.20  

836.52 

Permitivity 

(ε) 41.50  42.00  1.20  

835.00 0.90  0.88  -2.22  

836.52 

Conductivity 

(σ) S/m 0.90  0.88  -2.22  

±5 

 

LIQUID TYPE MSL-835 

SIMULATING LIQUID TEMP.  22.1 

TEST DATE Mar. 05, 2010 

TESTED BY Sam Onn 

FREQ. 
(MHz) 

LIQUID 
PARAMETER 

STANDARD 
VALUE 

MEASUREMENT 
VALUE 

ERROR 
PERCENTAGE 

(%%%%) 
LIMIT( % ) 

835.00 55.20  56.00  1.45  

836.52 

Permitivity 

(ε) 55.20  56.00  1.45  

835.00 0.97  0.96  -1.03  

836.52 

Conductivity 

(σ) S/m 0.97  0.96  -1.03  

±5 
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FOR CDMA1900 BAND SIMULATING LIQUID 

LIQUID TYPE HSL-1900 

SIMULATING LIQUID TEMP.  21.3 

TEST DATE Mar. 03, 2010 

TESTED BY Sam Onn 

FREQ. 
(MHz) 

LIQUID 
PARAMETER 

STANDARD 
VALUE 

MEASUREMENT 
VALUE 

ERROR 
PERCENTAGE 

(%%%%) 
LIMIT( % ) 

1851.25 40.00  41.30  3.25  

1880.00 40.00  41.20  3.00  

1900.00 40.00  41.10  2.75  

1908.75 

Permitivity 

(ε) 

40.00  41.00  2.50  

1851.25 1.40  1.37  -2.14  

1880.00 1.40  1.41  0.71  

1900.00 1.40  1.44  2.86  

1908.75 

Conductivity 

(σ) S/m 

1.40  1.45  3.57  

±5 

 

LIQUID TYPE MSL-1900 

SIMULATING LIQUID TEMP.  21.2 

TEST DATE Mar. 03, 2010 

TESTED BY Sam Onn 

FREQ. 
(MHz) 

LIQUID 
PARAMETER 

STANDARD 
VALUE 

MEASUREMENT 
VALUE 

ERROR 
PERCENTAGE 

(%%%%) 
LIMIT( % ) 

1851.25 53.30  54.50  2.25  

1880.00 53.30  54.40  2.06  

1900.00 53.30  54.30  1.88  

1908.75 

Permitivity 

(ε) 

53.30  54.20  1.69  

1851.25 1.52  1.50  -1.32  

1880.00 1.52  1.53  0.66  

1900.00 1.52  1.55  1.97  

1908.75 

Conductivity 

(σ) S/m 

1.52  1.57  3.29  

±5 
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6. SYSTEM VALIDATION 

The system validation was performed in the flat phantom with equipment listed in the 
following table. Since the SAR value is calculated from the measured electric field, 
dielectric constant and conductivity of the body tissue and the SAR is proportional to the 
square of the electric field. So, the SAR value will be also proportional to the RF power 
input to the system validation dipole under the same test environment. In our system 
validation test, 250mW RF input power was used. 
 

6.1 TEST PROCEDURE 

Before the system performance check, we need only to tell the system which components 
(probe, medium, and device) are used for the system performance check; the system will 
take care of all parameters. The dipole must be placed beneath the flat section of the SAM 
Twin Phantom with the correct distance holder in place. The distance holder should touch 
the phantom surface with a light pressure at the reference marking (little cross) and be 
oriented parallel to the long side of the phantom. Accurate positioning is not necessary, 
since the system will search for the peak SAR location, except that the dipole arms should 
be parallel to the surface. The device holder for mobile phones can be left in place but 
should be rotated away from the dipole. 

1. The ”Power Reference Measurement” and ”Power Drift Measurement” jobs are located 
at the beginning and end of the batch process. They measure the field drift at one single 
point in the liquid over the complete procedure. The indicated drift is mainly the variation 
of the amplifier output power. If it is too high (above ±0.1 dB), the system performance 
check should be repeated; some amplifiers have very high drift during warm-up. A 
stable amplifier gives drift results in the DASY system below ±0.02dB. 

2. The ”Surface Check” job tests the optical surface detection system of the DASY system 
by repeatedly detecting the surface with the optical and mechanical surface detector 
and comparing the results. The output gives the detecting heights of both systems, the 
difference between the two systems and the standard deviation of the detection 
repeatability. Air bubbles or refraction in the liquid due to separation of the sugar-water 
mixture gives poor repeatability (above ±0.1mm). In that case it is better to abort the 
system performance check and stir the liquid. 
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3. The ”Area Scan” job measures the SAR above the dipole on a plane parallel to the 
surface. It is used to locate the approximate location of the peak SAR. The proposed 
scan uses large grid spacing for faster measurement; due to the symmetric field, the 
peak detection is reliable. If a finer graphic is desired, the grid spacing can be reduced. 
Grid spacing and orientation have no influence on the SAR result. 

4. The ”Zoom Scan” job measures the field in a volume around the peak SAR value 
assessed in the previous ”Area Scan” job (for more information see the application note 
on SAR evaluation). 

About the validation dipole positioning uncertainty, the constant and low loss dielectric 
spacer is used to establish the correct distance between the top surface of the dipole and 
the bottom surface of the phantom, the error component introduced by the uncertainty of 
the distance between the liquid (i.e., phantom shell) and the validation dipole in the DASY5 
system is less than ±0.1mm. 

)1
)(

(100[%]
2

2

−+×=
a

da
SARtolerance  

As the closest distance is 10mm, the resulting tolerance SARtolerance[%] is <2%. 
 

6.2 VALIDATION RESULTS 

SYSTEM VALIDATION TEST OF SIMULATING LIQUID 

FREQUENCY 
(MHz) 

REQUIRED 
SAR (mW/g)  

MEASURED 
SAR (mW/g)  

DEVIATION 
(%) 

SEPARATION 
DISTANCE 

TESTED DATE 

HSL835 2.37 (1g) 2.27 -4.22 15mm Mar. 05, 2010 

MSL835 2.54 (1g) 2.43 -4.33 15mm Mar. 05, 2010 

HSL1900 10.20 (1g) 10.20 0.00 10mm Mar. 03, 2010 

MSL1900 10.20 (1g) 9.67 -5.20 10mm Mar. 03, 2010 

TESTED BY Sam Onn 

NOTE: Please see Appendix for the photo of system validation test. 
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6.3 SYSTEM VALIDATION UNCERTAINTIES  

In the table below, the system validation uncertainty with respect to the analytically assessed SAR value of a 
dipole source as given in the IEEE 1528 standard is given. This uncertainty is smaller than the expected 
uncertainty for mobile phone measurements due to the simplified setup and the symmetric field distribution. 

(Ci) 
Standard 

Uncertainty 
(±%) Error Description Tolerance 

(±%)  
Probability 
Distribution Divisor  

(1g) (10g) (1g) (10g) 

(v i) 

Measurement System  

Probe Calibration 5.50  Normal 1 1 1 5.50  5.50  ∞ 

Axial Isotropy 0.50  Rectangular √3 0.7 0.7 0.20  0.20  ∞ 

Hemispherical Isotropy  2.60  Rectangular √3 0.7 0.7 1.05  1.05  ∞ 

Boundary effects 1.00  Rectangular √3 1 1 0.58  0.58  ∞ 

Linearity 0.60  Rectangular √3 1 1 0.35  0.35  ∞ 

System Detection Limits  1.00  Rectangular √3 1 1 0.58  0.58  ∞ 

Readout Electronics 0.30  Normal 1 1 1 0.30  0.30  ∞ 

Response Time 0.80  Rectangular √3 1 1 0.46  0.46  ∞ 

Integration Time 2.60  Rectangular √3 1 1 1.50  1.50  ∞ 

RF Ambient Noise 3.00  Rectangular √3 1 1 1.73  1.73  ∞ 

RF Ambient Reflections  3.00  Rectangular √3 1 1 1.73  1.73  ∞ 

Probe Positioner 0.40  Rectangular √3 1 1 0.23  0.23  ∞ 

Probe Positioning 2.90  Rectangular √3 1 1 1.67  1.67  ∞ 

Max. SAR Eval. 1.00  Rectangular √3 1 1 0.58  0.58  ∞ 

Dipole Related 

Dipole Axis to Liquid 
Distance 2.00  Rectangular √3 1 1 1.15  1.15  145 

Input Power Drift 5.00  Rectangular √3 1 1 2.89  2.89  ∞ 

Phantom and Tissue parameters 

Phantom Uncertainty  4.00  Rectangular √3 1 1 2.31  2.31  ∞ 

Liquid Conductivity 
(target) 5.00  Rectangular √3 0.64 0.43 1.85  1.24  ∞ 

Liquid Conductivity 
(measurement) 3.57  Normal  1 0.64 0.43 2.28  1.54  ∞ 

Liquid Permittivity 
(target) 5.00  Rectangular √3 0.6 0.49 1.73  1.41  ∞ 

Liquid Permittivity 
(measurement) 3.25  Normal 1 0.6 0.49 1.95  1.59  ∞ 

Combined Standard Uncertainty 8.62  8.21    

Coverage Factor for 95% Kp=2 

Expanded Uncertainty (K=2) 17.25  16.41    

NOTE: About the system validation uncertainty assessment, please reference the section 7. 
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7. INFORMATION ON THE TESTING LABORATORIES 

We, Bureau Veritas Consumer Products Services (H.K.) Ltd., Taoyuan Branch, were 
founded in 1988 to provide our best service in EMC, Radio, Telecom and Safety 
consultation.  Our laboratories are accredited and approved according to ISO/IEC 17025. 

Copies of accreditation certificates of our laboratories obtained from approval 
agencies can be downloaded from our web site: www.adt.com.tw/index.5/phtml. If 
you have any comments, please feel free to contact us at the following: 

Linko EMC/RF Lab : 
Tel: 886-2-26052180 
Fax: 886-2-26051924 

Hsin Chu EMC/RF Lab : 
Tel: 886-3-5935343 
Fax: 886-3-5935342 

  
Hwa Ya EMC/RF/Safety/Telecom Lab : 
Tel: 886-3-3183232 
Fax: 886-3-3185050 

 

Web Site : www.adt.com.tw  

The address and road map of all our labs can be found in our web site also.  
 
 
 
---END--- 
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APPENDIX A: TEST DATA 
 
Liquid Level Photo  

 
Tissue HSL835MHz D=150mm 

 
 

Tissue MSL835MHz D=151mm 
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Tissue HSL1900MHz D=152mm 

 
 

Tissue MSL1900MHz D=155mm 

 
 
 
 



 

 A - 3

 
Date/Time: 2010/3/5 11:17:16  

Test Laboratory: Bureau Veritas ADT 

M01-Right Head-Cheek-CDMA_Cellular-Ch384 
 
DUT: Pocket PC Phone ; Type: PC36100  
 
Communication System: CDMA 1x ; Frequency: 836.52 MHz ; Duty Cycle: 1:1 
Medium: HSL850 Medium parameters used: f = 836.52 MHz; σ = 0.88 mho/m; εr = 42; ρ = 1000 kg/m3  
Phantom section: Right Section ; DUT test position : Cheek ; Modulation type: OQPSK 
  
DASY5 Configuration: 

• Probe: EX3DV3 - SN3504; ConvF(9.8, 9.8, 9.8) ; Calibrated: 2010/1/26     

• Sensor-Surface: 3mm (Mechanical Surface Detection)  

• Electronics: DAE3 Sn510; Calibrated: 2009/12/16  

• Phantom: SAM with CRP; Type: SAM; Serial: TP-1485  

• Measurement SW: DASY5, V5.2 Build 157;   

 
Touch Position - Mid. Ch384/Area Scan (7x11x1): Measurement grid: dx=15mm, dy=15mm 
Maximum value of SAR (measured) = 0.387 mW/g 
 
Touch Position - Mid. Ch384/Zoom Scan (7x7x9)/Cube 0: Measurement grid: dx=5mm, 
dy=5mm, dz=3mm 
Reference Value = 20.7 V/m; Power Drift = -0.132 dB 
Peak SAR (extrapolated) = 0.465 W/kg 
SAR(1 g) = 0.351 mW/g; SAR(10 g) = 0.256 mW/g 
Maximum value of SAR (measured) = 0.392 mW/g 
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Date/Time: 2010/3/5 11:43:54  

Test Laboratory: Bureau Veritas ADT 

M02-Right Head-Tilt-CDMA_Cellular-Ch384 
 
DUT: Pocket PC Phone ; Type: PC36100  
 
Communication System: CDMA 1x ; Frequency: 836.52 MHz ; Duty Cycle: 1:1 
Medium: HSL850 Medium parameters used: f = 836.52 MHz; σ = 0.88 mho/m; εr = 42; ρ = 1000 kg/m3  
Phantom section: Right Section ; DUT test position : Tilt ; Modulation type: OQPSK 
  
DASY5 Configuration: 

• Probe: EX3DV3 - SN3504; ConvF(9.8, 9.8, 9.8) ; Calibrated: 2010/1/26     

• Sensor-Surface: 3mm (Mechanical Surface Detection)  

• Electronics: DAE3 Sn510; Calibrated: 2009/12/16  

• Phantom: SAM with CRP; Type: SAM; Serial: TP-1485  

• Measurement SW: DASY5, V5.2 Build 157;   

 
Tilt Position - Mid. Ch384/Area Scan (7x11x1): Measurement grid: dx=15mm, dy=15mm 
Maximum value of SAR (measured) = 0.227 mW/g 
 
Tilt Position - Mid. Ch384/Zoom Scan (7x7x9)/Cube 0: Measurement grid: dx=5mm, dy=5mm, 
dz=3mm 
Reference Value = 14.8 V/m; Power Drift = 0.00782 dB 
Peak SAR (extrapolated) = 0.294 W/kg 
SAR(1 g) = 0.202 mW/g; SAR(10 g) = 0.147 mW/g 
aximum value of SAR (measured) = 0.229 mW/g 
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Date/Time: 2010/3/6 12:12:08  

Test Laboratory: Bureau Veritas ADT 

M03-Left Head-Cheek-CDMA_Cellular-Ch384 
 
DUT: Pocket PC Phone ; Type: PC36100  
 
Communication System: CDMA 1x ; Frequency: 836.52 MHz ; Duty Cycle: 1:1 
Medium: HSL850 Medium parameters used: f = 836.52 MHz; σ = 0.88 mho/m; εr = 42; ρ = 1000 kg/m3  
Phantom section: Left Section ; DUT test position : Cheek ; Modulation type: OQPSK 
  
DASY5 Configuration: 

• Probe: EX3DV3 - SN3504; ConvF(9.8, 9.8, 9.8) ; Calibrated: 2010/1/26     

• Sensor-Surface: 3mm (Mechanical Surface Detection)  

• Electronics: DAE3 Sn510; Calibrated: 2009/12/16  

• Phantom: SAM with CRP; Type: SAM; Serial: TP-1485  

• Measurement SW: DASY5, V5.2 Build 157;   

 
Touch Position - Mid. Ch384/Area Scan (7x11x1): Measurement grid: dx=15mm, dy=15mm 
Maximum value of SAR (measured) = 0.519 mW/g 
 
Touch Position - Mid. Ch384/Zoom Scan (7x7x9)/Cube 0: Measurement grid: dx=5mm, 
dy=5mm, dz=3mm 
Reference Value = 23.8 V/m; Power Drift = 0.058 dB 
Peak SAR (extrapolated) = 0.650 W/kg 
SAR(1 g) = 0.455 mW/g; SAR(10 g) = 0.320 mW/g 
Maximum value of SAR (measured) = 0.520 mW/g 
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Date/Time: 2010/3/6 12:55:25  

Test Laboratory: Bureau Veritas ADT 

M04-Left Head-Tilt-CDMA_Cellular-Ch384 
DUT: Pocket PC Phone ; Type: PC36100  
Communication System: CDMA 1x ; Frequency: 836.52 MHz ; Duty Cycle: 1:1 
Medium: HSL850 Medium parameters used: f = 836.52 MHz; σ = 0.88 mho/m; εr = 42; ρ = 1000 kg/m3  
Phantom section: Left Section ; DUT test position : Tilt ; Modulation type: OQPSK 
 DASY5 Configuration: 

• Probe: EX3DV3 - SN3504; ConvF(9.8, 9.8, 9.8) ; Calibrated: 2010/1/26     

• Sensor-Surface: 3mm (Mechanical Surface Detection)  

• Electronics: DAE3 Sn510; Calibrated: 2009/12/16  

• Phantom: SAM with CRP; Type: SAM; Serial: TP-1485  

• Measurement SW: DASY5, V5.2 Build 157;   

Tilt Position - Mid. Ch384/Area Scan (7x11x1): Measurement grid: dx=15mm, dy=15mm 
Maximum value of SAR (measured) = 0.318 mW/g 
Tilt Position - Mid. Ch384/Zoom Scan (7x7x9)/Cube 0: Measurement grid: dx=5mm, dy=5mm, 
dz=3mm 
Reference Value = 18.9 V/m; Power Drift = 0.00373 dB 
Peak SAR (extrapolated) = 0.473 W/kg 
SAR(1 g) = 0.284 mW/g; SAR(10 g) = 0.185 mW/g 
Maximum value of SAR (measured) = 0.334 mW/g 
Tilt Position - Mid. Ch384/Zoom Scan (7x7x9)/Cube 1: Measurement grid: dx=5mm, dy=5mm, 
dz=3mm 
Reference Value = 18.9 V/m; Power Drift = 0.00373 dB 
Peak SAR (extrapolated) = 0.312 W/kg 
SAR(1 g) = 0.232 mW/g; SAR(10 g) = 0.168 mW/g 
Maximum value of SAR (measured) = 0.266 mW/g 
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Date/Time: 2010/3/5 19:27:24  

Test Laboratory: Bureau Veritas ADT 

M05-Body-CDMA_Cellular-Ch384 / LCD Down 
 
DUT: Pocket PC Phone ; Type: PC36100  
 
Communication System: CDMA 1x ; Frequency: 836.52 MHz ; Duty Cycle: 1:1 
Medium: MSL900 Medium parameters used : f = 836.52 MHz; σ = 0.96 mho/m; εr = 56; ρ = 1000 kg/m3  
Phantom section: Flat Section ; DUT test position : Body ; Modulation Type: OQPSK 
Separation Distance : 15 mm ( The back side of the EUT to the Phantom)  
  
DASY5 Configuration: 

• Probe: EX3DV3 - SN3504; ConvF(9.83, 9.83, 9.83) ; Calibrated: 2010/1/26     

• Sensor-Surface: 3mm (Mechanical Surface Detection)  

• Electronics: DAE3 Sn510; Calibrated: 2009/12/16  

• Phantom: SAM with CRP; Type: SAM; Serial: TP-1485  

• Measurement SW: DASY5, V5.2 Build 157; SEMCAD X Version 14.0 Build 57  
 
Flat Section Mid. Ch384/Area Scan (7x11x1): Measurement grid: dx=15mm, dy=15mm 
Maximum value of SAR (measured) = 0.687 mW/g 
 
Flat Section Mid. Ch384/Zoom Scan (7x7x9)/Cube 0: Measurement grid: dx=5mm, dy=5mm, 
dz=3mm 
Reference Value = 26.7 V/m; Power Drift = -0.038 dB 
Peak SAR (extrapolated) = 0.852 W/kg 
SAR(1 g) = 0.636 mW/g; SAR(10 g) = 0.465 mW/g 
Maximum value of SAR (measured) = 0.718 mW/g 

 
 
 



 

 A - 8

 
Date/Time: 2010/3/5 20:01:07  

Test Laboratory: Bureau Veritas ADT 

M06-Body-CDMA_Cellular-Ch384 / LCD Up 
 
DUT: Pocket PC Phone ; Type: PC36100  
 
Communication System: CDMA 1x ; Frequency: 836.52 MHz ; Duty Cycle: 1:1 
Medium: MSL900 Medium parameters used : f = 836.52 MHz; σ = 0.96 mho/m; εr = 56; ρ = 1000 kg/m3  
Phantom section: Flat Section ; DUT test position : Body ; Modulation Type: OQPSK 
Separation Distance : 15 mm ( The front side of the EUT to the Phantom)  
  
DASY5 Configuration: 

• Probe: EX3DV3 - SN3504; ConvF(9.83, 9.83, 9.83) ; Calibrated: 2010/1/26     

• Sensor-Surface: 3mm (Mechanical Surface Detection)  

• Electronics: DAE3 Sn510; Calibrated: 2009/12/16  

• Phantom: SAM with CRP; Type: SAM; Serial: TP-1485  

• Measurement SW: DASY5, V5.2 Build 157; SEMCAD X Version 14.0 Build 57  
 
Flat Section Mid. Ch384 /Area Scan (7x11x1): Measurement grid: dx=15mm, dy=15mm 
Maximum value of SAR (measured) = 0.324 mW/g 
 
Flat Section Mid. Ch384 /Zoom Scan (7x7x9)/Cube 0: Measurement grid: dx=5mm, dy=5mm, 
dz=3mm 
Reference Value = 18.5 V/m; Power Drift = 0.032 dB 
Peak SAR (extrapolated) = 0.386 W/kg 
SAR(1 g) = 0.297 mW/g; SAR(10 g) = 0.224 mW/g 
Maximum value of SAR (measured) = 0.328 mW/g 
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Date/Time: 2010/3/5 21:23:46  

Test Laboratory: Bureau Veritas ADT 

M07-Body-CDMA_Cellular-Ch384 / LCD Down-Bat.2 
 
DUT: Pocket PC Phone ; Type: PC36100  
 
Communication System: CDMA 1x ; Frequency: 836.52 MHz ; Duty Cycle: 1:1 
Medium: MSL900 Medium parameters used : f = 836.52 MHz; σ = 0.96 mho/m; εr = 56; ρ = 1000 kg/m3  
Phantom section: Flat Section ; DUT test position : Body ; Modulation Type: OQPSK 
Separation Distance : 15 mm ( The back side of the EUT to the Phantom)  
  
DASY5 Configuration: 

• Probe: EX3DV3 - SN3504; ConvF(9.83, 9.83, 9.83) ; Calibrated: 2010/1/26     

• Sensor-Surface: 3mm (Mechanical Surface Detection)  

• Electronics: DAE3 Sn510; Calibrated: 2009/12/16  

• Phantom: SAM with CRP; Type: SAM; Serial: TP-1485  

• Measurement SW: DASY5, V5.2 Build 157; SEMCAD X Version 14.0 Build 57  
 
Flat Section Mid. Ch384/Area Scan (7x11x1): Measurement grid: dx=15mm, dy=15mm 
Maximum value of SAR (measured) = 0.654 mW/g 
 
Flat Section Mid. Ch384/Zoom Scan (7x7x9)/Cube 0: Measurement grid: dx=5mm, dy=5mm, 
dz=3mm 
Reference Value = 26.1 V/m; Power Drift = 0.091 dB 
Peak SAR (extrapolated) = 0.813 W/kg 
SAR(1 g) = 0.611 mW/g; SAR(10 g) = 0.449 mW/g 
Maximum value of SAR (measured) = 0.679 mW/g 
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Date/Time: 2010/3/3 11:05:22  

Test Laboratory: Bureau Veritas ADT 

M08-Right Head-Cheek-CDMA_PCS-Ch600 
 
DUT: Pocket PC Phone ; Type: PC31600  
 
Communication System: CDMA 1x ; Frequency: 1880 MHz ; Duty Cycle: 1:1 
Medium: HSL1900 Medium parameters used: f = 1880 MHz; σ = 1.41 mho/m; εr = 41.2; ρ = 1000 kg/m3  
Phantom section: Right Section ; DUT test position : Cheek ; Modulation type: OQPSK 
  
DASY5 Configuration: 

• Probe: EX3DV3 - SN3504; ConvF(8.2, 8.2, 8.2) ; Calibrated: 2010/1/26     

• Sensor-Surface: 3mm (Mechanical Surface Detection)  

• Electronics: DAE3 Sn510; Calibrated: 2009/12/16  

• Phantom: SAM with CRP; Type: SAM; Serial: TP-1485  

• Measurement SW: DASY5, V5.2 Build 157;   

Touch Position - Mid. Ch600/Area Scan (7x11x1): Measurement grid: dx=15mm, dy=15mm 
Maximum value of SAR (measured) = 0.862 mW/g 
 
Touch Position - Mid. Ch600/Zoom Scan (7x7x9)/Cube 0: Measurement grid: dx=5mm, 
dy=5mm, dz=3mm 
Reference Value = 24.5 V/m; Power Drift = 0.097 dB 
Peak SAR (extrapolated) = 1.26 W/kg 
SAR(1 g) = 0.705 mW/g; SAR(10 g) = 0.383 mW/g 
Maximum value of SAR (measured) = 0.893 mW/g 
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Date/Time: 2010/3/3 11:32:50  

Test Laboratory: Bureau Veritas ADT 

M09-Right Head-Tilt-CDMA_PCS-Ch25 
 
DUT: Pocket PC Phone ; Type: PC31600  
 
Communication System: CDMA 1x ; Frequency: 1851.25 MHz ; Duty Cycle: 1:1 
Medium: HSL1900 Medium parameters used : f = 1851.25 MHz; σ = 1.37 mho/m; εr = 41.3; ρ = 1000 
kg/m3  
Phantom section: Right Section ; DUT test position : Tilt ; Modulation type: OQPSK 
  
DASY5 Configuration: 

• Probe: EX3DV3 - SN3504; ConvF(8.2, 8.2, 8.2) ; Calibrated: 2010/1/26     

• Sensor-Surface: 3mm (Mechanical Surface Detection)  

• Electronics: DAE3 Sn510; Calibrated: 2009/12/16  

• Phantom: SAM with CRP; Type: SAM; Serial: TP-1485  

• Measurement SW: DASY5, V5.2 Build 157;   

Tilt Position - Low Ch25/Area Scan (7x11x1): Measurement grid: dx=15mm, dy=15mm 
Maximum value of SAR (measured) = 1.14 mW/g 
 
Tilt Position - Low Ch25/Zoom Scan (7x7x9)/Cube 0: Measurement grid: dx=5mm, dy=5mm, 
dz=3mm 
Reference Value = 27.9 V/m; Power Drift = 0.017 dB 
Peak SAR (extrapolated) = 1.74 W/kg 
SAR(1 g) = 0.998 mW/g; SAR(10 g) = 0.544 mW/g 
Maximum value of SAR (measured) = 1.22 mW/g 
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Date/Time: 2010/3/3 11:58:06  

Test Laboratory: Bureau Veritas ADT 

M09-Right Head-Tilt-CDMA_PCS-Ch600 
 
DUT: Pocket PC Phone ; Type: PC31600  
 
Communication System: CDMA 1x ; Frequency: 1880 MHz ; Duty Cycle: 1:1 
Medium: HSL1900 Medium parameters used: f = 1880 MHz; σ = 1.41 mho/m; εr = 41.2; ρ = 1000 kg/m3  
Phantom section: Right Section ; DUT test position : Tilt ; Modulation type: OQPSK 
  
DASY5 Configuration: 

• Probe: EX3DV3 - SN3504; ConvF(8.2, 8.2, 8.2) ; Calibrated: 2010/1/26     

• Sensor-Surface: 3mm (Mechanical Surface Detection)  

• Electronics: DAE3 Sn510; Calibrated: 2009/12/16  

• Phantom: SAM with CRP; Type: SAM; Serial: TP-1485  

• Measurement SW: DASY5, V5.2 Build 157;   

Tilt Position - Mid. Ch600/Area Scan (7x11x1): Measurement grid: dx=15mm, dy=15mm 
Maximum value of SAR (measured) = 0.963 mW/g 
 
Tilt Position - Mid. Ch600/Zoom Scan (7x7x9)/Cube 0: Measurement grid: dx=5mm, dy=5mm, 
dz=3mm 
Reference Value = 25.2 V/m; Power Drift = -0.118 dB 
Peak SAR (extrapolated) = 1.53 W/kg 
SAR(1 g) = 0.867 mW/g; SAR(10 g) = 0.466 mW/g 
Maximum value of SAR (measured) = 1.06 mW/g 
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Date/Time: 2010/3/3 12:31:42  

Test Laboratory: Bureau Veritas ADT 

M09-Right Head-Tilt-CDMA_PCS-Ch1175 
 
DUT: Pocket PC Phone ; Type: PC31600  
 
Communication System: CDMA 1x ; Frequency: 1908.75 MHz ; Duty Cycle: 1:1 
Medium: HSL1900 Medium parameters used : f = 1908.75 MHz; σ = 1.45 mho/m; εr = 41; ρ = 1000 
kg/m3  
Phantom section: Right Section ; DUT test position : Tilt ; Modulation type: OQPSK 
  
DASY5 Configuration: 

• Probe: EX3DV3 - SN3504; ConvF(8.2, 8.2, 8.2) ; Calibrated: 2010/1/26     

• Sensor-Surface: 3mm (Mechanical Surface Detection)  

• Electronics: DAE3 Sn510; Calibrated: 2009/12/16  

• Phantom: SAM with CRP; Type: SAM; Serial: TP-1485  

• Measurement SW: DASY5, V5.2 Build 157;   

Tilt Position - High Ch1175/Area Scan (7x11x1): Measurement grid: dx=15mm, dy=15mm 
Maximum value of SAR (measured) = 1.13 mW/g 
 
Tilt Position - High Ch1175/Zoom Scan (7x7x9)/Cube 0: Measurement grid: dx=5mm, 
dy=5mm, dz=3mm 
Reference Value = 27.2 V/m; Power Drift = -0.011 dB 
Peak SAR (extrapolated) = 1.75 W/kg 
SAR(1 g) = 0.977 mW/g; SAR(10 g) = 0.526 mW/g 
Maximum value of SAR (measured) = 1.19 mW/g 
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Date/Time: 2010/3/3 12:57:56  

Test Laboratory: Bureau Veritas ADT 

M10-Left Head-Cheek-CDMA_PCS-Ch25 
 
DUT: Pocket PC Phone ; Type: PC31600  
 
Communication System: CDMA 1x ; Frequency: 1851.25 MHz ; Duty Cycle: 1:1 
Medium: HSL1900 Medium parameters used : f = 1851.25 MHz; σ = 1.37 mho/m; εr = 41.3; ρ = 1000 
kg/m3  
Phantom section: Left Section ; DUT test position : Cheek ; Modulation type: OQPSK 
  
DASY5 Configuration: 

• Probe: EX3DV3 - SN3504; ConvF(8.2, 8.2, 8.2) ; Calibrated: 2010/1/26     

• Sensor-Surface: 3mm (Mechanical Surface Detection)  

• Electronics: DAE3 Sn510; Calibrated: 2009/12/16  

• Phantom: SAM with CRP; Type: SAM; Serial: TP-1485  

• Measurement SW: DASY5, V5.2 Build 157;   

Touch Position - Low Ch25/Area Scan (7x11x1): Measurement grid: dx=15mm, dy=15mm 
Maximum value of SAR (measured) = 1.18 mW/g 
 
Touch Position - Low Ch25/Zoom Scan (7x7x9)/Cube 0: Measurement grid: dx=5mm, 
dy=5mm, dz=3mm 
Reference Value = 28.3 V/m; Power Drift = 0.028 dB 
Peak SAR (extrapolated) = 1.9 W/kg 
SAR(1 g) = 0.966 mW/g; SAR(10 g) = 0.506 mW/g 
Maximum value of SAR (measured) = 1.24 mW/g 
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Date/Time: 2010/3/3 13:26:20  

Test Laboratory: Bureau Veritas ADT 

M10-Left Head-Cheek-CDMA_PCS-Ch600 
 
DUT: Pocket PC Phone ; Type: PC31600  
 
Communication System: CDMA 1x ; Frequency: 1880 MHz ; Duty Cycle: 1:1 
Medium: HSL1900 Medium parameters used: f = 1880 MHz; σ = 1.41 mho/m; εr = 41.2; ρ = 1000 kg/m3  
Phantom section: Left Section ; DUT test position : Cheek ; Modulation type: OQPSK 
  
DASY5 Configuration: 

• Probe: EX3DV3 - SN3504; ConvF(8.2, 8.2, 8.2) ; Calibrated: 2010/1/26     

• Sensor-Surface: 3mm (Mechanical Surface Detection)  

• Electronics: DAE3 Sn510; Calibrated: 2009/12/16  

• Phantom: SAM with CRP; Type: SAM; Serial: TP-1485  

• Measurement SW: DASY5, V5.2 Build 157;   

Touch Position - Mid.600/Area Scan (7x11x1): Measurement grid: dx=15mm, dy=15mm 
Maximum value of SAR (measured) = 1.03 mW/g 
 
Touch Position - Mid.600/Zoom Scan (7x7x9)/Cube 0: Measurement grid: dx=5mm, dy=5mm, 
dz=3mm 
Reference Value = 27.4 V/m; Power Drift = -0.143 dB 
Peak SAR (extrapolated) = 1.62 W/kg 
SAR(1 g) = 0.828 mW/g; SAR(10 g) = 0.423 mW/g 
Maximum value of SAR (measured) = 0.99 mW/g 
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Date/Time: 2010/3/3 13:52:21  

Test Laboratory: Bureau Veritas ADT 

M10-Left Head-Cheek-CDMA_PCS-Ch1175 
 
DUT: Pocket PC Phone ; Type: PC31600  
 
Communication System: CDMA 1x ; Frequency: 1908.75 MHz ; Duty Cycle: 1:1 
Medium: HSL1900 Medium parameters used : f = 1908.75 MHz; σ = 1.45 mho/m; εr = 41; ρ = 1000 
kg/m3  
Phantom section: Left Section ; DUT test position : Cheek ; Modulation type: OQPSK 
  
DASY5 Configuration: 

• Probe: EX3DV3 - SN3504; ConvF(8.2, 8.2, 8.2) ; Calibrated: 2010/1/26     

• Sensor-Surface: 3mm (Mechanical Surface Detection)  

• Electronics: DAE3 Sn510; Calibrated: 2009/12/16  

• Phantom: SAM with CRP; Type: SAM; Serial: TP-1485  

• Measurement SW: DASY5, V5.2 Build 157;   

Touch Position - High Ch1175/Area Scan (7x11x1): Measurement grid: dx=15mm, dy=15mm 
Maximum value of SAR (measured) = 1.20 mW/g 
 
Touch Position - High Ch1175/Zoom Scan (7x7x9)/Cube 0: Measurement grid: dx=5mm, 
dy=5mm, dz=3mm 
Reference Value = 28 V/m; Power Drift = 0.089 dB 
Peak SAR (extrapolated) = 1.86 W/kg 
SAR(1 g) = 0.939 mW/g; SAR(10 g) = 0.486 mW/g 
Maximum value of SAR (measured) = 1.21 mW/g 
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Date/Time: 2010/3/3 14:18:25  

Test Laboratory: Bureau Veritas ADT 

M11-Left Head-Tilt-CDMA_PCS-Ch25 
 
DUT: Pocket PC Phone ; Type: PC31600  
 
Communication System: CDMA 1x ; Frequency: 1851.25 MHz ; Duty Cycle: 1:1 
Medium: HSL1900 Medium parameters used : f = 1851.25 MHz; σ = 1.37 mho/m; εr = 41.3; ρ = 1000 
kg/m3  
Phantom section: Left Section ; DUT test position : Tilt ; Modulation type: OQPSK 
  
DASY5 Configuration: 

• Probe: EX3DV3 - SN3504; ConvF(8.2, 8.2, 8.2) ; Calibrated: 2010/1/26     

• Sensor-Surface: 3mm (Mechanical Surface Detection)  

• Electronics: DAE3 Sn510; Calibrated: 2009/12/16  

• Phantom: SAM with CRP; Type: SAM; Serial: TP-1485  

• Measurement SW: DASY5, V5.2 Build 157;   

Tilt Position - Low Ch25/Area Scan (7x11x1): Measurement grid: dx=15mm, dy=15mm 
Maximum value of SAR (measured) = 1.27 mW/g 
 
Tilt Position - Low Ch25/Zoom Scan (7x7x9)/Cube 0: Measurement grid: dx=5mm, dy=5mm, 
dz=3mm 
Reference Value = 29.7 V/m; Power Drift = -0.030 dB 
Peak SAR (extrapolated) = 1.9 W/kg 
SAR(1 g) = 1.03 mW/g; SAR(10 g) = 0.538 mW/g 
Maximum value of SAR (measured) = 1.33 mW/g 
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Date/Time: 2010/3/3 14:44:13  
Test Laboratory: Bureau Veritas ADT 

M11-Left Head-Tilt-CDMA_PCS-Ch600 
 
DUT: Pocket PC Phone ; Type: PC31600  
 
Communication System: CDMA 1x ; Frequency: 1880 MHz ; Duty Cycle: 1:1 
Medium: HSL1900 Medium parameters used: f = 1880 MHz; σ = 1.41 mho/m; εr = 41.2; ρ = 1000 kg/m3  
Phantom section: Left Section ; DUT test position : Tilt ; Modulation type: OQPSK 
  
DASY5 Configuration: 

• Probe: EX3DV3 - SN3504; ConvF(8.2, 8.2, 8.2) ; Calibrated: 2010/1/26     

• Sensor-Surface: 3mm (Mechanical Surface Detection)  

• Electronics: DAE3 Sn510; Calibrated: 2009/12/16  

• Phantom: SAM with CRP; Type: SAM; Serial: TP-1485  

• Measurement SW: DASY5, V5.2 Build 157;   

Tilt Position - Mid. Ch600/Area Scan (7x11x1): Measurement grid: dx=15mm, dy=15mm 
Maximum value of SAR (measured) = 1.14 mW/g 
 
Tilt Position - Mid. Ch600/Zoom Scan (7x7x9)/Cube 0: Measurement grid: dx=5mm, dy=5mm, 
dz=3mm 
Reference Value = 27.8 V/m; Power Drift = 0.052 dB 
Peak SAR (extrapolated) = 1.74 W/kg 
SAR(1 g) = 0.927 mW/g; SAR(10 g) = 0.482 mW/g 
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Date/Time: 2010/3/3 15:10:19  

Test Laboratory: Bureau Veritas ADT 

M11-Left Head-Tilt-CDMA_PCS-Ch1175 
 
DUT: Pocket PC Phone ; Type: PC31600  
 
Communication System: CDMA 1x ; Frequency: 1908.75 MHz ; Duty Cycle: 1:1 
Medium: HSL1900 Medium parameters used : f = 1908.75 MHz; σ = 1.45 mho/m; εr = 41; ρ = 1000 
kg/m3  
Phantom section: Left Section ; DUT test position : Tilt ; Modulation type: OQPSK 
  
DASY5 Configuration: 

• Probe: EX3DV3 - SN3504; ConvF(8.2, 8.2, 8.2) ; Calibrated: 2010/1/26     

• Sensor-Surface: 3mm (Mechanical Surface Detection)  

• Electronics: DAE3 Sn510; Calibrated: 2009/12/16  

• Phantom: SAM with CRP; Type: SAM; Serial: TP-1485  

• Measurement SW: DASY5, V5.2 Build 157;   

Tilt Position - High Ch1175/Area Scan (7x11x1): Measurement grid: dx=15mm, dy=15mm 
Maximum value of SAR (measured) = 1.23 mW/g 
 
Tilt Position - High Ch1175/Zoom Scan (7x7x9)/Cube 0: Measurement grid: dx=5mm, 
dy=5mm, dz=3mm 
Reference Value = 29.2 V/m; Power Drift = 0.025 dB 
Peak SAR (extrapolated) = 1.87 W/kg 
SAR(1 g) = 1 mW/g; SAR(10 g) = 0.517 mW/g 
Maximum value of SAR (measured) = 1.25 mW/g 
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Date/Time: 2010/3/3 18:31:41  

Test Laboratory: Bureau Veritas ADT 

M12-CDMA_PCS-Ch25 / LCD Down 
 
DUT: Pocket PC Phone ; Type: PC36100  
 
Communication System: CDMA 1x ; Frequency: 1851.25 MHz ; Duty Cycle: 1:1 
Medium: MSL1900 Medium parameters used: f = 1851.25 MHz; σ = 1.5 mho/m; εr = 54.5; ρ = 1000 
kg/m3  
Phantom section: Flat Section ; DUT test position : Body ; Modulation Type: OQPSK 
Separation Distance : 15 mm ( The back side of the EUT to the Phantom)  
  
DASY5 Configuration: 

• Probe: EX3DV3 - SN3504; ConvF(8.52, 8.52, 8.52) ; Calibrated: 2010/1/26     

• Sensor-Surface: 3mm (Mechanical Surface Detection)  

• Electronics: DAE3 Sn510; Calibrated: 2009/12/16  

• Phantom: SAM with CRP; Type: SAM; Serial: TP-1485  

• Measurement SW: DASY5, V5.2 Build 157; SEMCAD X Version 14.0 Build 57  
 
Flat-Section Low Ch25/Area Scan (7x11x1): Measurement grid: dx=15mm, dy=15mm 
Maximum value of SAR (measured) = 1.1 mW/g 
 
Flat-Section Low Ch25/Zoom Scan (7x7x9)/Cube 0: Measurement grid: dx=5mm, dy=5mm, 
dz=3mm 
Reference Value = 27.3 V/m; Power Drift = 0.029 dB 
Peak SAR (extrapolated) = 1.6 W/kg 
SAR(1 g) = 0.953 mW/g; SAR(10 g) = 0.533 mW/g 
Maximum value of SAR (measured) = 1.17 mW/g 
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Date/Time: 2010/3/3 18:58:12  

Test Laboratory: Bureau Veritas ADT 

M12-CDMA_PCS-Ch600 / LCD Down 
 
DUT: Pocket PC Phone ; Type: PC36100  
 
Communication System: CDMA 1x ; Frequency: 1880 MHz ; Duty Cycle: 1:1 
Medium: MSL1900 Medium parameters used: f = 1880 MHz; σ = 1.53 mho/m; εr = 54.4; ρ = 1000 kg/m3  
Phantom section: Flat Section ; DUT test position : Body ; Modulation Type: OQPSK 
Separation Distance : 15 mm ( The back side of the EUT to the Phantom)  
  
DASY5 Configuration: 

• Probe: EX3DV3 - SN3504; ConvF(8.52, 8.52, 8.52) ; Calibrated: 2010/1/26     

• Sensor-Surface: 3mm (Mechanical Surface Detection)  

• Electronics: DAE3 Sn510; Calibrated: 2009/12/16  

• Phantom: SAM with CRP; Type: SAM; Serial: TP-1485  

• Measurement SW: DASY5, V5.2 Build 157; SEMCAD X Version 14.0 Build 57  
 
Flat-Section Mid. Ch600/Area Scan (7x11x1): Measurement grid: dx=15mm, dy=15mm 
Maximum value of SAR (measured) = 0.967 mW/g 
 
Flat-Section Mid. Ch600/Zoom Scan (7x7x9)/Cube 0: Measurement grid: dx=5mm, dy=5mm, 
dz=3mm 
Reference Value = 25.3 V/m; Power Drift = 0.036 dB 
Peak SAR (extrapolated) = 1.37 W/kg 
SAR(1 g) = 0.812 mW/g; SAR(10 g) = 0.449 mW/g 
Maximum value of SAR (measured) = 0.999 mW/g 
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Date/Time: 2010/3/3 19:27:18  

Test Laboratory: Bureau Veritas ADT 

M12-CDMA_PCS-Ch1175 / LCD Down 
 
DUT: Pocket PC Phone ; Type: PC36100  
 
Communication System: CDMA 1x ; Frequency: 1908.75 MHz ; Duty Cycle: 1:1 
Medium: MSL1900 Medium parameters used: f = 1908.75 MHz; σ = 1.57 mho/m; εr = 54.2; ρ = 1000 
kg/m3  
Phantom section: Flat Section ; DUT test position : Body ; Modulation Type: OQPSK 
Separation Distance : 15 mm ( The back side of the EUT to the Phantom)  
  
DASY5 Configuration: 

• Probe: EX3DV3 - SN3504; ConvF(8.52, 8.52, 8.52) ; Calibrated: 2010/1/26     

• Sensor-Surface: 3mm (Mechanical Surface Detection)  

• Electronics: DAE3 Sn510; Calibrated: 2009/12/16  

• Phantom: SAM with CRP; Type: SAM; Serial: TP-1485  

• Measurement SW: DASY5, V5.2 Build 157; SEMCAD X Version 14.0 Build 57  
 
Flat-Section High Ch1175/Area Scan (7x11x1): Measurement grid: dx=15mm, dy=15mm 
Maximum value of SAR (measured) = 1.16 mW/g 
 
Flat-Section High Ch1175/Zoom Scan (7x7x9)/Cube 0: Measurement grid: dx=5mm, dy=5mm, 
dz=3mm 
Reference Value = 27.4 V/m; Power Drift = -0.041 dB 
Peak SAR (extrapolated) = 1.64 W/kg 
SAR(1 g) = 0.961 mW/g; SAR(10 g) = 0.524 mW/g 
Maximum value of SAR (measured) = 1.19 mW/g 
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Date/Time: 2010/3/3 20:31:58  

Test Laboratory: Bureau Veritas ADT 

M13-CDMA_PCS-Ch600 / LCD Up 
DUT: Pocket PC Phone ; Type: PC36100  
Communication System: CDMA 1x ; Frequency: 1880 MHz ; Duty Cycle: 1:1 
Medium: MSL1900 Medium parameters used: f = 1880 MHz; σ = 1.53 mho/m; εr = 54.4; ρ = 1000 kg/m3  
Phantom section: Flat Section ; DUT test position : Body ; Modulation Type: OQPSK 
Separation Distance : 15 mm ( The front side of the EUT to the Phantom)  
 DASY5 Configuration: 

• Probe: EX3DV3 - SN3504; ConvF(8.52, 8.52, 8.52) ; Calibrated: 2010/1/26     

• Sensor-Surface: 3mm (Mechanical Surface Detection)  

• Electronics: DAE3 Sn510; Calibrated: 2009/12/16  

• Phantom: SAM with CRP; Type: SAM; Serial: TP-1485  

• Measurement SW: DASY5, V5.2 Build 157; SEMCAD X Version 14.0 Build 57  

Flat-Section Mid. Ch600/Area Scan (7x11x1): Measurement grid: dx=15mm, dy=15mm 
Maximum value of SAR (measured) = 0.248 mW/g 
Flat-Section Mid. Ch600/Zoom Scan (7x7x9)/Cube 0: Measurement grid: dx=5mm, dy=5mm, 
dz=3mm 
Reference Value = 0 V/m; Power Drift = 0.099 dB 
Peak SAR (extrapolated) = 0.351 W/kg 
SAR(1 g) = 0.224 mW/g; SAR(10 g) = 0.145 mW/g 
Maximum value of SAR (measured) = 0.263 mW/g 
Flat-Section Mid. Ch600/Zoom Scan (7x7x9)/Cube 1: Measurement grid: dx=5mm, dy=5mm, 
dz=3mm 
Reference Value = 0 V/m; Power Drift = 0.099 dB 
Peak SAR (extrapolated) = 0.317 W/kg 
SAR(1 g) = 0.191 mW/g; SAR(10 g) = 0.108 mW/g 
Maximum value of SAR (measured) = 0.241 mW/g 
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Date/Time: 2010/3/3 16:24:59  

Test Laboratory: Bureau Veritas ADT 

M14-Left Head-Tilt-CDMA_PCS-Ch25 / Bat2 
 
DUT: Pocket PC Phone ; Type: PC31600  
 
Communication System: CDMA 1x ; Frequency: 1851.25 MHz ; Duty Cycle: 1:1 
Medium: HSL1900 Medium parameters used : f = 1851.25 MHz; σ = 1.37 mho/m; εr = 41.3; ρ = 1000 
kg/m3  
Phantom section: Left Section ; DUT test position : Tilt ; Modulation type: OQPSK 
  
DASY5 Configuration: 

• Probe: EX3DV3 - SN3504; ConvF(8.2, 8.2, 8.2) ; Calibrated: 2010/1/26     

• Sensor-Surface: 3mm (Mechanical Surface Detection)  

• Electronics: DAE3 Sn510; Calibrated: 2009/12/16  

• Phantom: SAM with CRP; Type: SAM; Serial: TP-1485  

• Measurement SW: DASY5, V5.2 Build 157;   

Tilt Position - Low Ch25/Area Scan (7x11x1): Measurement grid: dx=15mm, dy=15mm 
Maximum value of SAR (measured) = 1.07 mW/g 
 
Tilt Position - Low Ch25/Zoom Scan (7x7x9)/Cube 0: Measurement grid: dx=5mm, dy=5mm, 
dz=3mm 
Reference Value = 27.5 V/m; Power Drift = 0.055 dB 
Peak SAR (extrapolated) = 1.89 W/kg 
SAR(1 g) = 0.998 mW/g; SAR(10 g) = 0.516 mW/g 
Maximum value of SAR (measured) = 1.25 mW/g 
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 Date/Time: 2010/3/5 10:21:55  

Test Laboratory: Bureau Veritas ADT 

SystemPerformanceCheck-HSL835 MHz 
 
DUT: Dipole 835 MHz ; Type: D835V2 ; Serial: 4d021 ; Test Frequency: 835 MHz  
 
Communication System: CW ; Frequency: 835 MHz; Duty Cycle: 1:1; Modulation type: CW 
Medium: HSL850;Medium parameters used: f = 835 MHz; σ = 0.88 mho/m; εr = 42; ρ = 1000 kg/m3 ; 
Liquid level : 150 mm  
Phantom section: Flat Section ; Separation distance : 15 mm (The feetpoint of  the dipole to the 
Phantom)Air temp. : 22.8 degrees ; Liquid temp. : 21.5 degrees 

 DASY5 Configuration: 

• Probe: EX3DV3 - SN3504; ConvF(9.8, 9.8, 9.8) ; Calibrated: 2010/1/26     

• Sensor-Surface: 3mm (Mechanical Surface Detection)  

• Electronics: DAE3 Sn510; Calibrated: 2009/12/16  

• Phantom: SAM with CRP; Type: SAM; Serial: TP-1485  

• Measurement SW: DASY5, V5.2 Build 157; SEMCAD X Version 14.0 Build 57  
 
System Performance Check at Frequencies 835 MHz/d=15mm, Pin=250 mW, 
dist=3.0mm /Area Scan (7x9x1): Measurement grid: dx=15mm, dy=15mm 
Maximum value of SAR (measured) = 2.56 mW/g 
 
System Performance Check at Frequencies 835 MHz/d=15mm, Pin=250 mW, 
dist=3.0mm /Zoom Scan (7x7x7)/Cube 0: Measurement grid: dx=5mm, dy=5mm, dz=5mm 
Reference Value = 54.8 V/m; Power Drift = -0.106 dB 
Peak SAR (extrapolated) = 3.43 W/kg 
SAR(1 g) = 2.27 mW/g; SAR(10 g) = 1.47 mW/g 
Maximum value of SAR (measured) = 2.66 mW/g 
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Date/Time: 2010/3/5 18:03:58  

Test Laboratory: Bureau Veritas ADT 

SystemPerformanceCheck-MSL835 MHz 
 
DUT: Dipole 835 MHz ; Type: D835V2 ; Serial: 4d021 ; Test Frequency: 835 MHz  
 
Communication System: CW ; Frequency: 835 MHz; Duty Cycle: 1:1; Modulation type: CW 
Medium: MSL900;Medium parameters used: f = 835 MHz; σ = 0.96 mho/m; εr = 56; ρ = 1000 kg/m3 ; 
Liquid level : 151 mm  
Phantom section: Flat Section ; Separation distance : 15 mm (The feetpoint of  the dipole to the 
Phantom)Air temp. : 23 degrees ; Liquid temp. : 22.1 degrees 

 DASY5 Configuration: 

• Probe: EX3DV3 - SN3504; ConvF(9.83, 9.83, 9.83) ; Calibrated: 2010/1/26     

• Sensor-Surface: 3mm (Mechanical Surface Detection)  

• Electronics: DAE3 Sn510; Calibrated: 2009/12/16  

• Phantom: SAM with CRP; Type: SAM; Serial: TP-1485  

• Measurement SW: DASY5, V5.2 Build 157; SEMCAD X Version 14.0 Build 57  
 
System Performance Check at Frequencies 835 MHz/d=15mm, Pin=250 mW, 
dist=3.0mm /Area Scan (7x9x1): Measurement grid: dx=15mm, dy=15mm 
Maximum value of SAR (measured) = 2.68 mW/g 
 
System Performance Check at Frequencies 835 MHz/d=15mm, Pin=250 mW, 
dist=3.0mm /Zoom Scan (7x7x7)/Cube 0: Measurement grid: dx=5mm, dy=5mm, dz=5mm 
Reference Value = 55.2 V/m; Power Drift = 0.0068 dB 
Peak SAR (extrapolated) = 3.66 W/kg 
SAR(1 g) = 2.43 mW/g; SAR(10 g) = 1.58 mW/g 
Maximum value of SAR (measured) = 2.85 mW/g 
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 Date/Time: 2010/3/3 10:26:36  

Test Laboratory: Bureau Veritas ADT 

SystemPerformanceCheck-HSL1900 MHz 
 
DUT: Dipole 1900 MHz ; Type: D1900V2 ; Serial: 5d022 ; Test Frequency: 1900 MHz  
 
Communication System: CW ; Frequency: 1900 MHz; Duty Cycle: 1:1; Modulation type: CW 
Medium: HSL1900;Medium parameters used: f = 1900 MHz; σ = 1.44 mho/m; εr = 41.1; ρ = 1000 kg/m3 ; 
Liquid level : 152 mm  
Phantom section: Flat Section ; Separation distance : 10 mm (The feetpoint of  the dipole to the 
Phantom)Air temp. : 22.6 degrees ; Liquid temp. : 21.3 degrees 

 DASY5 Configuration: 

• Probe: EX3DV3 - SN3504; ConvF(8.2, 8.2, 8.2); Calibrated: 2010/1/26  

• Sensor-Surface: 3mm (Mechanical Surface Detection)  

• Electronics: DAE3 Sn510; Calibrated: 2009/12/16  

• Phantom: SAM with CRP; Type: SAM; Serial: TP-1485  

• Measurement SW: DASY5, V5.2 Build 157;   

 
System Performance Check at Frequencies 1.9 GHz/d=10mm, Pin=250 mW, 
dist=3.0mm /Area Scan (7x7x1): Measurement grid: dx=15mm, dy=15mm 
Maximum value of SAR (measured) = 10.7 mW/g 
 
System Performance Check at Frequencies 1.9 GHz/d=10mm, Pin=250 mW, 
dist=3.0mm /Zoom Scan (7x7x7)/Cube 0: Measurement grid: dx=5mm, dy=5mm, dz=5mm 
Reference Value = 95.9 V/m; Power Drift = -0.075 dB 
Peak SAR (extrapolated) = 19.8 W/kg 
SAR(1 g) = 10.2 mW/g; SAR(10 g) = 5.15 mW/g 
Maximum value of SAR (measured) = 13.1 mW/g 

 



 

 A - 29

 
Date/Time: 2010/3/3 17:42:51  

Test Laboratory: Bureau Veritas ADT 

SystemPerformanceCheck-MSL1900MHz 
DUT: Dipole 1900 MHz ; Type: D1900V2 ; Serial: 5d022 ; Test Frequency: 1900 MHz  
 
Communication System: CW ; Frequency: 1900 MHz; Duty Cycle: 1:1; Modulation type: CW 
Medium: MSL1900;Medium parameters used: f = 1900 MHz; σ = 1.55 mho/m; εr = 54.3; ρ = 1000 
kg/m3 ; Liquid level : 155 mm  
Phantom section: Flat Section ; Separation distance : 10 mm (The feetpoint of  the dipole to the 
Phantom)Air temp. : 22.4 degrees ; Liquid temp. : 21.2 degrees 

 DASY5 Configuration: 

• Probe: EX3DV3 - SN3504; ConvF(8.52, 8.52, 8.52) ; Calibrated: 2010/1/26    

• Sensor-Surface: 3mm (Mechanical Surface Detection)  

• Electronics: DAE3 Sn510; Calibrated: 2009/12/16  

• Phantom: SAM with CRP; Type: SAM; Serial: TP-1485  

• Measurement SW: DASY5, V5.2 Build 157; SEMCAD X Version 14.0 Build 57  
 
System Performance Check at Frequencies 1.9 GHz/d=10mm, Pin=250 mW, dist=3.0mm 
/Area Scan (7x7x1): Measurement grid: dx=15mm, dy=15mm 
Maximum value of SAR (measured) = 10.2 mW/g 
 
System Performance Check at Frequencies 1.9 GHz/d=10mm, Pin=250 mW, dist=3.0mm 
/Zoom Scan (7x7x7)/Cube 0: Measurement grid: dx=5mm, dy=5mm, dz=5mm 
Reference Value = 90.5 V/m; Power Drift = -0.133 dB 
Peak SAR (extrapolated) = 18.1 W/kg 
SAR(1 g) = 9.67 mW/g; SAR(10 g) = 5.02 mW/g 
Maximum value of SAR (measured) = 12.1 mW/g 

 
 


